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Our Mission:  To administer justice fairly while providing excellent service to those we serve. 

Filing Fees Increased June 1 

 Please note that the fees for filing a new case, splitting a case, and 

for adversary proceedings increased effective June 1, 2014.  This fee 

increase also affects installment amounts, where applicable: 

 Chapter 7        $335.00 

 Voluntary, Involuntary, or Split Joint Case  

 Suggested installment amounts of $125.00 with the filing 
of the petition and three monthly installments of $70.00  

 
Chapter 9       $1717.00 
 
Chapter 11       $1717.00 

 Voluntary, Involuntary or  Split Joint Case  
 

Chapter 12       $275.00 
 Voluntary or Split Joint Case 

 Suggested installment amounts of $95.00 with the filing 
of the petition and three monthly installment payments 
of $60.00 

 
Chapter 13       $310.00 

 Voluntary or Split Joint Case 

 Suggested installment amounts of $100.00 with the filing 
of the petition and three monthly installments of $70.00  

 
Chapter 15       $1717.00 
 
Adversary Proceeding  $350.00 
 

 Please ensure that your bankruptcy software, if used, is updated to 

the most current version to include these fee changes. 

Please see page 3 of this publication for more changes effective 

June 1 and those that will take effect December 1. 
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Welcome Libby Deroche! 

 Libby joined the Clerk’s Office as a Case Administrator in the Pensacola Divisional Office 

on June 16.  She has worked in the bankruptcy field for nineteen years for attorneys in the 

Fort Worth, Texas, area and more recently for the Amy Sliva Law Office in Pensacola.  With 

her understanding of the bankruptcy system and her sunny disposition, we anticipate that Libby will be a tre-

mendous asset to the Clerk’s Office.   Welcome to the court family, Libby! 

 
 

Proposed Orders 

 

Proposed orders are not to be submitted in CM/ECF 
as an attachment to the matter to which it relates.   
 

 Proposed orders that are attached to the docket 
entry of the pleading or matter to which it relates 
will not be processed.  

“Portal” Training for Mortgage Modifica-
tion Mediation is Coming Soon  

to a City Near You! 

By Judge Specie 

 As you have read in the prior edition of our 

Newsletter, our District has joined with the Mid-

dle and Southern Districts of Florida in an effort to 

make mortgage modification mediation (“MMM”) 

uniform throughout Florida.  Our District’s Stand-

ing Chapter 13 Trustee, Leigh Hart, is working 

with the Chapter 13 Trustee from the Middle Dis-

trict of Florida to arrange training on a secure 

“Portal” for use in uploading documents needed 

for mediation, and for facilitating communications 

between parties to mediation.  As soon our court 

receives confirmation of date(s) for training, we 

will send out an announcement and post the in-

formation on the Court’s website. 

Docketing Attachments or Exhibits in CM/ECF 

 When uploading attachments to a pleading in CM/ECF, filers may use the “Category” options presented 

but must also use the “Description” field to fully describe the nature of each attachment.   

ECF Essentials 

Tips       &   Tricks 

Update on Proposed Orders Submission Issue:   

We continue to experience technical difficulties 
which prohibit the submission of proposed orders 
through CM/ECF and have caused the failure of 
ECF Central and our Public Calendar.  Our IT team 
is diligently working on this issue.  Please continue 
to monitor our website at www.flnb.uscourts.gov 
for updates and instructions on submitting pro-
posed orders until this issue is resolved.   

http://www.flnb.uscourts.gov
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Forms Changes Effective June 1 

 As part of the U.S. Courts’ Forms Modernization Project the names of a few official bankruptcy forms were 

changed effective June 1, 2014.  In response, the names of the filing events in CM/ECF have been updated to 

reflect the new names as shown below:  

 Application for Individuals to Pay the Filing Fee in Installments  

 Application for Waiver of Chapter 7 Filing Fee  

 Notice to Individual Consumer Debtor  

Forms Changes Effective December 1 

 Several new forms will become effective on December 1, 2014, as will several form name and form number 

changes to current forms.  The new and renamed forms as well as the new form numbers are shown below: 

 Form 17A  Notice of Appeal and Statement of Election  

 Form 17B  Optional Appellee Statement of Election to Proceed in District Court  

 Form 17C  Certificate of Compliance with Rule 8015(a)(7)(B) or 8016(d)(2) 

 Form 22A-1  Chapter 7 Statement of Your Current Monthly Income  

 Form 22A-1Supp  Statement of Exemption from Presumption of Abuse Under § 707(b)(2) 

 Form 22A-2  Chapter 7 Means Test Calculation  

 Form 22B  Chapter 11 Statement of Your Current Monthly Income  

 Form 22C-1  Chapter 13 Statement of Your Current Monthly Income and Calculation of Commitment 

Period  

 Form 22C-2  Chapter 13 Calculation of Your Disposable Income  

 Please be aware that these changes may require an update to any bankruptcy petition preparation soft-

ware you use. 

The Evolution of U.S. Bankruptcy Law:  a time line 

Have you ever wondered how it all got started in the United States?  The Evolution of U.S. 
Bankruptcy Law: a time line, a publication by the Federal Judicial Center, provides a unique 
time line mapping the evolution of bankruptcy law from its inception in 1787 in the U.S. 
Constitution through 2011.  It also provides statistics demonstrating the burgeoning bank-
ruptcy caseloads, and historical snapshots of select sociopolitical events that occurred 
along the way.  Take a look! 

www.fjc.gov/public/pdf.nsf/lookup/bktimeline2012.pdf/$file/bktimeline2012.pdf 

HELP DESK HINTS… Web Browser Compatibility 

 CM/ECF has been tested and is compatible with the following internet browsers:   

Firefox and Internet Explorer 8 and 9 only.  It has not been tested with later versions of Internet  

Explorer, Chrome, Opera, Safari, or other browsers.  We cannot guaranty their compatibility with  

CM/ECF.   

 If you are using a later version of Internet Explorer, you must ensure that you are running  

“compatibility mode” to file and view documents in CM/ECF.   

http://www.fjc.gov/public/pdf.nsf/lookup/bktimeline2012.pdf/$file/bktimeline2012.pdf
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Telephonic (CourtCall) Hearings 

By Judge Specie 

 At present, this District's telephonic hearings are held using CourtCall, a service that charges a fee for each 

person making a telephonic appearance.  On our website, and on telephonic hearing notices, you will see:  

 II. SCHEDULING A TELEPHONIC APPEARANCE  

By Telephone: Absent an emergency, telephone appearances must be arranged by calling CourtCall   

at (866) 582-6878 not later than 3:00 p.m. one day prior to the hearing date.  In an emergency, you 

may contact chambers at 850-521-5031.   For additional details regarding CourtCall appearances see:  

www.flnb.uscourts.gov/sites/default/files/court_resources/telephonic_appearance_procedures.pdf.   
   

 More and more frequently attorneys/staff are telephoning chambers (as well as the Clerk's office who 

then refer the calls to chambers) the day of, just prior to or during a hearing to ask permission to appear via 

Court Call.   Some are unfamiliar with the CourtCall procedure; some have had calendaring issues in their 

offices; and others simply did not read the instructions until the last minute.  Each time a party requests to 

join a hearing at the last minute it creates extra work for Chambers, the Courtroom Deputy and others. Sel-

dom has there been a true "emergency" that justifies permitting a party to appear via CourtCall at the last 

minute.    

 Although of late we have been accommodating most last minute requests, it is too disruptive to Court per-

sonnel and the Judge's hearing calendar to continue to do so.   Please note, AND TELL YOUR STAFF, that the 

Court intends to begin (again) enforcing the CourtCall scheduling requirements shown above.  DO NOT EX-

PECT  LAST MINUTE REQUESTS TO APPEAR VIA COURTCALL TO BE GRANTED, unless you or your staff pre-

sent what, to the Court, qualifies as a true "emergency."  Failure to plan ahead or to read the rules regard-

ing telephonic appearances is NOT an emergency.  PLAN ACCORDINGLY. 

N.D. Fla. LBR 3012-1 
Valuation of Collateral & Response to Notice 

 

 Local Rule 3012-1 specifies disclosure of proposed valuation of collateral and responses thereto.  Respons-

es to the valuation of collateral are to be filed in the form of a Motion to Value Property or a Motion to De-

termine Secured Status and specific supporting documentation is required.  

 Please review this Local Rule to ensure that you are in compliance with our requirements.  Failure to file 

the required documents or failure to file your response to the Notice of Valuation in the proper form will re-

sult in a Submission Error Notification.   

 Local Rules for the U.S. Bankruptcy Court for the Northern District of Florida are available on our website at 

www.flnb.uscourts.gov/sites/default/files/local_rules/local_rules_12_1_2011a.pdf. 

 

 The current Local Rules Revision Cycle is in the final stages of review and approval.  We anticipate  
the revised Local Rules will be effective December 1, 2014.  More information as well as a summary of the 

changes will be provided closer to that time.  

http://www.flnb.uscourts.gov/sites/default/files/court_resources/telephonic_appearance_procedures.pdf
http://www.flnb.uscourts.gov/sites/default/files/local_rules/local_rules_12_1_2011a.pdf
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Inability to view documents or receiving a blank page when viewing documents 

If you are experiencing this issue, you may need to adjust some settings in your Adobe Reader.  
Try  the suggestions below and make sure you open a new browser session after making any of 
the changes.  
 

Check the version of Adobe Reader you are using, then try the following:  

 Settings for Adobe Acrobat 4.0  

 On the toolbar 

 Select File->Preference->General->Options 

 Remove the check mark under Web Browser Integration 

 Settings for Adobe Reader 5.0  

 On the toolbar 

 Select Edit->Preference->General->Options 

 On the right hand side of the screen, uncheck the following features: 

 Display PDF in Browser and Allow Fast Web View 

 Settings for Adobe Reader 6.0, 7.0, 8.0 or 9.0  

 On the toolbar 

 Select Edit->Preference->Internet 

 On the right hand side of the screen, uncheck the following features: 

 Display PDF in Browser and Allow Fast Web View 
 

See the PACER “Frequently Asked Questions” page for help with other issues you may be having. 

    

           THE  CLERK’S CORNER                                                          By: Traci Abrams, Clerk of Court  

Teamwork Saves the Day! 

 During April of 2014, the Pensacola division received the heaviest rainfall in one day since the late 1800s. 
Many homes and roadways were damaged due to flooding as were businesses. The Winston Arnow Federal 
Building flooded with over 1000 gallons of water in the basement level.  As a result, the Bankruptcy Clerk’s 
Office in Pensacola was temporarily closed.   

 The Director of Court Operations and her Tallahassee Operations staff pitched in and covered all of the 
daily activities for the Pensacola Case Administrators. The docket activity for the prior day received a quality 
control review, phone calls on Pensacola cases were answered, hearing schedules were updated for attor-
neys who practice in both Pensacola and Panama City, and twenty-nine 341 meetings were rescheduled. 
The Tallahassee team was glad to help and knew that the Pensacola staff would have offered the same great 
service for them had it been needed.  

 Judge Karen Specie and the Clerk’s Office management team are very proud of the way the case work was 
handled efficiently and without complaint, especially with the threat of flooding in Tallahassee as well.  Even 
though the Tallahassee office closed an hour early due to the impending storm, all of the work was done by 
the time staff had left. 

 In addition, I would like to thank my Chief Deputy who was in Tallahassee and traveled back to Pensacola 
during a low point in the storm. He was able to survey building damage, liaise with GSA and building support 
staff, and perform his emergency point of contact role for the Clerk’s Office. 

 Judge Specie and I are very thankful and feel extremely fortunate to have such a dedicated and talented 
court team in place.  

http://www.pacer.gov/psc/hfaq.html
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How to Get Your Proposed Orders Signed Faster 

 The Clerk’s Office staff and Judge Specie’s Judicial Assistant spend countless hours making modifications to 

many of the proposed orders we receive to meet Judge Specie’s basic language and formatting requirements 

or to correct  punctuation and spelling errors.  We are also directed by chambers to return many proposed 

orders to attorneys for the following most common reasons: 

 Title of the order does not exactly match the title of the motion or application and/or does not in-
clude the document number of the matter to which it relates 

 Correct dispositive language was not used or the disposition is not included 

 Body of the order does not contain the document number or name of the motion or document to 
which it relates 

 Does not contain the name of the person who prepared the order 

 Amended order does not contain an explanation of the amendment  

 References to proofs of claim or docketed items do not contain the full name and docket or claim 
number 

 Order on objection to claim does not include the address of the claimant  

 Order on objection to claim does not include the amount of the claim to be disallowed (may not use 
“disallowed in its entirety”) 

 Incorrect formatting 

 Motion to Amend Order not filed pursuant to Fed. R. Bankr. P. 9013 

 The judge will not sign the order as drafted (typographical errors, incorrect language, etc.) 

 Order grants more relief than requested in motion 

 Order does not show to whom it is being sent 
 

 To  ensure that your orders are processed expeditiously, please make certain that all proposed orders 

meet the following guidelines which are also available on our website at www.flnb.uscourts.gov/sites/

default/files/filing_requirements/4-inst.pdf.   

TITLE: The title of the proposed order should contain the disposition of the matter, contain the name of 
the movant and the docket number of the related matter, and should completely match the title of the 
related matter (ONLY ONE MATTER PER ORDER).   
 

DISPOSITION: The correct disposition terminology should be used:  
 

Motions are granted or denied. 
Objections are sustained or overruled. 
Applications are approved or disapproved. 
Non-dispositional language such as “Order on Motion” will not be accepted. 

 

BODY: The opening paragraph of the proposed order should contain the document number of the mo-
tion or document to which the order is related. 
 

PREPARED BY: The name of the attorney who prepared the proposed order is to be indicated 
at the end of the document.   
 

See Proposed Orders on Page 7 

http://www.flnb.uscourts.gov/sites/default/files/filing_requirements/4-inst.pdf
http://www.flnb.uscourts.gov/sites/default/files/filing_requirements/4-inst.pdf
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AMENDED ORDERS: Amended orders must contain a footnote explaining why the original order is being 
amended.  
 

REFERENCED DOCUMENTS: Proposed orders which contain references to Proofs of Claim or items on 
the docket such as responses, amendments, etc., should contain the name(s) and docket or claim number
(s) of those items.  
 

OBJECTIONS TO CLAIMS: Orders sustaining objections to claims should clearly indicate the amount of 
the claim to be disallowed.  Do not simply state “claim is disallowed in its entirety.”  
 

PLAIN LANGUAGE: Utilize plain language as follows:  
 

CORRECT:  “It is Ordered.”  
INCORRECT:  Accordingly; Hereby; Therefore; Adjudged and Decreed; Whereas 
INCORRECT:  “The Court is of the opinion…” or “The Court having reviewed the file…”  

 

CORRECT:  “No party filed an objection within the prescribed time period, the court considers the 
matter unopposed.”  
INCORRECT:  “No response having been filed, the court is of the opinion that the Motion is    
  due to be  granted.”  
 

FORMAT:  
 Documents must be double spaced and contain only basic formatting.  
 Use the same font type and size throughout the document (preferably 12 pt. font).  
 When using properly spelled Latin terms (e.g. in rem), you must either underline the term or use 

Italic font.  
 Ensure that the correct judge’s initials appear after the case number within the header.  
 Ensure that the Chapter identification, e.g., Chapter 7, appears above or below the case number 

within the header.  
 The name of the attorney who prepared the order is to be indicated at the end of the document.  
 To save space, position the judge’s signature line approximately one (1) inch below the date line.  

 

To view examples or for additional requirements, please visit our website at www.flnb.uscourts.gov/filing-

requirements/instructions-and-procedures-chambers. 

Proposed Orders  (continued) 

No Ex Parte Communications 

 

 Judge Specie shall not engage in ex parte communication of any kind.  Bankruptcy Rule 9003 states: “any 

party in interest, and any attorney, accountant, or employee of a party in interest shall refrain from ex 

parte meetings and communications with the court concerning matters affecting a particular case or pro-

ceeding.”  Failure to comply with this rule may result in sanctions. 

  Do not write letters to, e-mail, or call Judge Specie or her Law Clerks on any pending case or proceed-

ing.  Except in extremely unusual circumstances, each letter or e-mail addressed to Judge Specie or her Law 

Clerks, or sent to the court and identifying a particular case or proceeding, will be placed on the relevant 

docket and made part of the public record.  Any such letter or e-mail may be set for hearing. 

http://www.flnb.uscourts.gov/filing-requirements/instructions-and-procedures-chambers
http://www.flnb.uscourts.gov/filing-requirements/instructions-and-procedures-chambers
http://www.law.cornell.edu/rules/frbp/rule_9003
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Views & News from the Bench 
By: Karen K. Specie 

United States Bankruptcy Judge, Northern District of Florida 

PRO BONO SERVICES – PLEASE CONSIDER WALKING THE WALK 

 

 Florida lawyers know, but our court staff and non-lawyers may not, that every lawyer admitted to the Flori-
da Bar took a solemn oath to serve the  “cause of the defenseless and oppressed.”  This oath means, in prac-
tical terms, that every Florida lawyer has given his or her word to provide legal service free of charge to the 
poor.1  

Pro se filings – cases filed by people who do not have lawyers -- in our court are on the rise.  What 
does that mean to you?  Most likely, that our case processing, hearing dockets and hearings may slow down.  
Pro se cases consume more bench time and Clerk of Court staff time.   Due to Federal budget cuts and down-
sizing, our case administrators are already working as hard and fast as they can.  Papers filed by unrepresent-
ed litigants can be very lengthy, address sometimes inapplicable issues and be difficult to understand.  Other 
times these papers are simply so brief as to make it difficult to determine just what relief is requested and 
why. So it takes more time for the Court and its staff to ascertain how to handle these filings. When a party is 
unfamiliar with evidentiary and procedural rules, that party’s case can move at a snail’s pace; couple that 
with the fact that in the Eleventh Circuit bankruptcy judges are required by case law to be lenient with unrep-
resented parties, and you and your client can end up frustrated.  The client’s case can be fraught with delays 
and additional attorneys’ fees and expense.   

 On behalf of myself and our entire court, I sincerely thank the attorneys in our District who have represent-
ed parties in bankruptcy pro bono.  Those of you who have not taken a case or adversary proceeding pro bo-
no, I urge you to do so -- we need you!   Yes, Florida lawyers may fulfill their Florida Bar professional responsi-
bility requirements by donating money (the Supreme Court suggested contribution is $350.00 per year) for 
pro bono services.  But donated money does not make court cases or dockets go any faster.  PLEASE consider 
walking the walk, and take a pro bono case or adversary proceeding today. 
 

UNITED STATES SUPREME COURT RULES ON  
Executive Benefits Insurance Agency v. Arkison (In re Bellingham Ins. Agency, Inc.) 2

 

 

 On June 9, 2014 the Supreme Court issued its long-awaited decision in the “Bellingham,” or “Executive 
Benefits” case.  The Court granted Certiorari in a case from the United States Court of Appeals for the Ninth 
Circuit, apparently to address a key question that had split the Circuits:  may a bankruptcy (Article I) court is-
sue a final judgment over a state law claim with consent of the parties?3 The Ninth Circuit had said yes, but 
the Fifth, Sixth, and Seventh Circuits have said no.  Rather than resolve the split, the Supreme Court held that 
because in Bellingham the District Court (Article III court) had already reviewed the bankruptcy court’s final 
judgment de novo,4 it was unnecessary to reach the ultimate issue.  This case, like Stern,5 appears likely to 
generate more case law on which issues can be finally decided by bankruptcy courts; it has already begun to 
generate significant “expert” commentary.  It remains to be seen whether this ruling will, as a practical 
matter, change anything at the bankruptcy court level on how “Stern” type issues are handled. 

1The Latin term for such service is pro bono publico, meaning for the public good, which we in the legal field shorten to pro bono. 

2Case No. 11-35162 (9th Cir. December 4, 2012). 

3District Courts are Article III courts because District judges have lifetime tenure and their salaries may not be changed by the Legislature.  Bankruptcy Courts are 
Article I courts because bankruptcy judges do not have lifetime tenure and their salaries may be adjusted by Congress.  

4Pursuant to 28 USC 157 (c)(1). 

5Stern v. Marshall, 546 U.S. _____, 131 S.Ct. 2594, 10 L.Ed. 2d 475 (2011). 
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NORTHERN DISTRICT OF FLORIDA BANKRUPTCY BAR ASSOCIATION 

2014 Annual Seminar 
September 18-19, 2014 

Registration Fee:  $200 

(NO INCREASE!) 

Includes annual membership dues, cocktail reception on 

Thursday night at the Hilton Sandestin Beach Golf Re-

sort beachside deck, and breakfast, lunch & beverages 

during the seminar Friday 

Hilton Sandestin Beach Golf Resort 

Seminar Room Rate:  $199.00 per night  

Hotel reservations made separately and 

must be made by August 18th. 

Golf Outing & Cocktail Reception - Thursday, September 18 

 A golf outing will take place on Thursday afternoon, September 18th at 1:00 p.m., Central Time, at the Bay-

towne Golf Club.  The cost will be $83.00 per person.  Please RSVP to Michael Moody at 

moodym@gtlaw.com or Conor McLaughlin at cmclaughlin@qpwblaw.com for the golf outing.   

 The Annual Cocktail Reception will be Thursday night, September 18th at 6:00 p.m., Central Time, at the 

Hilton Sandestin Beach Golf Resort beachside deck.  If you or your firm would like to sponsor the reception, 

please contact Brian Rich at brich@bergersingerman.com.   

Bronze - $150   Silver - $250   Gold - $350   Platinum - $500      

Title Sponsorship - $1000 
 
 
 
 

SEMINAR & MEMBERSHIP MEETING - FRIDAY, SEPTEMBER 19 

8:00 am 

 

8:45 am 

 

 

9:00 am 

 

 

 

9:40 am 

 

 

 

 

 

 

10:30 am 

 

10:40 am 

 

11:00 am 

Continental Breakfast & Late Registration 

 

Welcome 
Russell B. Buchanan, Esq. - Baker Donelson 

 

Case Law Update 
James E. Sorenson, Esq. - Williams, Gautier, 

Gwynn, DeLoach & Sorenson 

 

Onebearance, twobearance, threebearance, 

forbearance: The Calculus Behind the For-

bearance Process 
Honorable Jerry A. Funk, Middle District of 

Florida Bankruptcy Judge & Roy S. Kobert - 

GrayRobinson, P.A. 

 

Coffee Break 
 

U.S. Trustee’s Office Update 

 

View from the Bench 
Honorable Karen K. Specie 

Honorable Margaret A. Mahoney 

Honorable William S. Shulman 

12:00 pm 

 

 

1:00 pm 

 

 

2:00 pm 

 

 

 

 

2:45 pm 

 

3:00 pm 

 

 

3:30 pm 

 

4:00 pm 

 

 

4:45 pm 

Lunch Break & Annual Membership Meeting 
Russell B. Buchanan, Esq. 

 

Ethics and Professionalism 
Honorable Lewis M. Killian, Jr. 

 

Talking in Code: The UCC, Tax Code, & 

Bankruptcy Code 
Douglas A. Bates, Esq. - Clark, Partington, Hart, 

Larry, Bond & Stackhouse 

 

Coffee Break 
 

Chapter 13 Trustee Q&A  
William C. Miller  

 

Clerk’s Office Update 
 

Exemptions Update 
John E. Venn, Jr., Esq. 

 

Closing Remarks 
Russell B. Buchanan, Esq. 

mailto:moodym@gtlaw.com?subject=NDFLBBA%20Seminar
mailto:cmclaughlin@qpwblaw.com?subject=NDFLBBA%20Seminar
mailto:brich@bergersingerman.com?subject=NDFLBBA%20Seminar
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Northern District of Florida Bankruptcy Bar Association 

2014 Annual Seminar Registration Form 

 

Return this sheet with your check (made payable to the Northern District of Florida Bankruptcy Bar Associa-

tion, Inc.) to:  Michael H. Moody, Esq., moodym@gtlaw.com, (850) 425-8544, Greenberg Traurig, P.A., 101 

East College Avenue, Tallahassee, FL 32301.   

      I am attending the seminar and joining NDFLBBA for the first time ($200) 

      I am attending the seminar and renewing my membership in  NDFLBBA ($200) 

      I am attending the seminar as a full-time legal services attorney or first year attorney ($150) 

      I am not attending the seminar but would like to join/renew my membership in NDFLABBA ($50) 

 

Name:                                                 

 

Firm Name:                                               

 

Mailing Address:                                            

 

                                                  

 

Phone Number:                                            

 

Fax Number:                                              

 

E-mail Address:                                             

Changes to eFinCert Effective August 1, 2014 

 Effective August 1, 2014, filers will be required to enter a PACER login and password to file financial man-

agement certificates through the eFinCert program in the Northern District of Florida.   

 Registration with PACER is free and can be done through their website at www.pacer.gov/register.html.  

Please note that you will not register directly with our court.  Questions regarding the registration process 

should be directed to the PACER Service Center at pacer@psc.uscourts.gov or (800) 676-6856.   

mailto:moodym@gtlaw.com?subject=NDFLBBA%20Seminar
http://www.pacer.gov/register.html
mailto:pacer@psc.uscourts.gov
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 Cases in the Northern District of Florida are randomly assigned to Case Administrators throughout the 
district shortly after filing.   The name of the Case Administrator to whom a particular case is  assigned is lo-
cated at the top of the docket report in CM/ECF.   

 

The Clerk’s Office phones are answered from 9:00 a.m.  until 4:00 p.m., Monday through Friday,  
except federal holidays.  Please feel free to call or email the Case Administrators 

with your procedural questions.  The Clerk’s Office is not permitted to answer legal questions nor 
can they provide guidance as to the content or types of documents that may be required. 

CMECF_HelpDesk@flnb.uscourts.gov 

Please visit us on the web at www.flnb.uscourts.gov 

 FLNB Resources Rev.  06/14 

Ann Kennington 
(850) 470-3060 

 
Carolyn Romine 
(850) 470-3062 

 
Claire Bikowitz 
(850) 521-5016 

Latonia Isom 
(850) 521-5012 

 
Libby Deroche 
(850) 470-3061 

 
Lisa Davis 

(850) 521-5010 
 

Janet Nah 
Courtroom Deputy & 

Calendar Clerk 
(850) 521-5009 

 
Melanie Lawrence 

(407) 237-8021 
For cases assigned to judge 

Jennemann (FLMB) only 

Ne’Shoni Love-Beane 
CM/ECF Login & Password 

(850) 521-5011 
(866) 639-4615 

 
Help Desk 

(850) 521-5001 
(850) 765-1752 

The monthly filing and closing statistics for the U.S. Bankruptcy Court for the Northern District of Florida are posted to the Court Resources page of our website at 

www.flnb.uscourts.gov.  Statistical information will be available by the 15th of each month.  
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mailto:CMECF_HelpDesk@flnb.uscourts.gov
http://www.flnb.uscourts.gov
http://www.flnb.uscourts.gov/court-filing-statistics
http://www.flnb.uscourts.gov

